
Start ArcCatalog.  Right-click on Geodatabase, select Properties.  
Type in a new Domain Name.  
Click the field to the right of Field Type and select a type 
(such as Text).  
Enter the Coded Values with Description for your tags.
Click Apply and OK, and exit from ArcCatalog.

Start ArcMap, open a Map Document, which has 
the geologic data in it, or add the data to it (Fig. 2a and 2b).  
Right click the Feature  Class to link the Domain, 
Click Open Attribute Table.
On the Attribute Table, click Options button, and select 
Add Field. 
Type in the Name of the new field.
Click the drop arrow to right of Type and select Text.
Click to right of Domain and select the Domain previously
created in ArcCatalog.  Click OK  The attribute table will 
now have the new field in it at the end.  

Save ArcMap, and
start an Edit Session.

Click in a record to tag, select a tag from the drop menu, and tag
feature. 

Save edits.
Save ArcMap
Document.

In the Data View, click the Full Extent (Globe button) 
so map is zoomed out.  Then click the Layout View.   

Click File > Page Setup.  Choose plotter, 
paper size, orientation of page. 
Deselect the Scale map to page size box,  
or the map will not be a true scale.

If the frame of the map is small,
click the corner with the arrow
tool and drag it to the larger size.
Then specify map scale in the box 
at the top.

File > Export.
Name the file for exporting.
Chose from the drop list, the
type of file (here Illustrator).
Click Export button.  The
file will be created, and 
should open in Adobe
Illustrator.  If this doesn't 
work well, try other formats
for exporting.  
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Converting Geologic Maps from Coverages to Geodatabases
by Karen Wheeler, Philip Dinterman, Russell Evarts, and Ray Wells

INTRODUCTION

The Pacific Northwest Urban Corridor Geologic 
Mapping project is providing digital 1:24000 scale 
geologic mapping of areas in western Oregon and 
Washington.  Our databases are online, with 
documentation describing the datasets at:  
http://geology.wr.usgs.gov/wgmt/pacnw.

	Online releases from 1995-2002 include:                

1) Database packageArcInfo coverage export (.e00), 
grids,  AMLs, symbolsets, readme and metadata
2) PostScript packageEncapsulated PostScript files 
for printing 
3) PDF packageAdobe Acrobat PDF files for viewing 
and printing 
 In 2002, we began using ArcGIS for database 
management and map creation.  The data structure for 
our databases followed the Alacarte standard 
(Fitzgibbon,  1991; Fitzgibbon and Wentworth, 1991; 
Wentworth and Fitzgibbon, 1991).  Our project has 
converted almost all our pre-existing coverages from 
Workstation ArcInfo to ArcGIS 8.3 geodatabases. 

Current packages produced for the website include:
1) Geodatabase packageGeodatabase, Metadata, 
and ArcMap document for viewing and querying
2) Shapefile packageShapefiles exported from 
Geodatabase
3) PDF packagePDFs of the geologic map and 
pamphet

We are adding more data to our geodatabases, 
improving our collection of data with ArcPad, 
developing styles for ArcMap which make the maps 
more uniform, streamlining the map production with 
templates, and improving our metadata.  A typical 
conversion of one geologic map from coverages to a 
Geodatabase takes about 10 minutes or less.  

COVERAGES TO GEODATABASE

1) In ArcCatalog
Specify a New Personal Geodatabase (Fig. 1a).  Add 
Feature Datasets such as geology, locations, and 
structure (Fig. 1b).   
Create a Feature Class in that Feature Dataset or 
import coverages into the Feature Dataset as Feature 
Classes (Fig. 1c).
If desired, specify Domains for tagging in ArcMap (Fig. 
1d).  A Domain is the range of values allowed for a 
column in a database. 

2) In ArcMap
Create a new Map Document  (Fig. 2a).  Add data from 
newly created geodatabase (Fig. 2b).
Use Styles or a previous Layer file for symbology (Fig. 
2c).

Export the map at a specified scale, to EPS or to Adobe 
Illustrator (Fig. 2d).  Place exported EPS of map in an 
Illustrator map template for printing.  

Our latest geologic map as a geodatabase is on this 
poster (Fig. 3).  It was originally compiled on mylar and 
greenlines, scanned, and digitized into Workstation 
Arc/Info.  It was imported into a Personal Geodatabase, 
edited in ArcMap, and exported to a graphic file for 
Illustrator. 

PUBLISHED GEODATABASES

Our first geodatabase, Maps showing Inundation 
depths, ice-rafted erratics, and sedimentary facies of the 
Late Pleistocene Missoula Floods of the Willamette Valley, 
Oregon, was published in 2003 and is online at:  
http://geopubs.wr.usgs.gov/open-file/of03-408.  It 
consists of shapefiles, a geodatabase and metadata, 
PDFs of maps, and a readme.  

Our next two geodatabases, Geologic Map of the Ariel 
Quadrangle, Clark and Cowlitz Counties, Washington, 
and  Geologic Map of the Woodland Quadrangle, Clark 
and Cowlitz Counties, Washington, are standard 7.5 
minute USGS geologic maps, and will be released May 
2004, as Scientific Investigations Maps (SIM) at: 
http://pubs.usgs.gov/sim/2826 and 
http://pubs.usgs.gov/sim/2827. 

FUTURE DIRECTIONS

We are testing ArcPad on an IPAQ PDA with GPS.  
Forms developed in ArcPad are used to collect point 
data for sample locations, structural measurements, 
geologic unit, date, time, and notes.  For base maps in 
ArcPad, we use ArcCatalog to export the DRGs to 
MrSIDs.  Having data points in ArcMap as shapefiles 
saves time time digitizing the points.  The initial test 
maps were at the first draft stage much faster than 
they would have been with previous conventional 
attempts.   Existing Geodatabases in ArcMap can be 
exported to ArcPad and used in the field to add more 
information, and later reimport the shapefiles.  A 
poster on ArcPad by Evan Thoms and Ralph Haugerud 
is also presented at this conference.

PEFile, a Windows CE utility, was purchased to view the 
filename list with extensions, which were otherwise 
not visible on Windows CE, running on Compaq IPAQs.  
Cost has been minimal for 2 of these units and PEFile. 

ArcSDE is being testing for multiuser editing of 
Geodatabases and managing large image catalogs.  It 
is simple to convert the ArcGIS Personal Geodatabases 
to ArcSDE databases. 
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 Open ArcCatalog and create a Personal Geodatabase. Open ArcMap and create a New Map Document. Right click the Layers in the Table of Contents frame, and specify the Coordinate System, and scale.

Use ArcCatalog to create a Personal Geodatabase Use ArcMap to symbolize a Geologic Map of the Geodatabase and export Most Recent Geologic Map (scaled down 85% for poster)

Rename the Geodatabase.

Create a Feature Dataset in that geodatabase 
(right click the name of the geodatabase).

Create a Feature Class in that Feature Dataset 
(right click the name of the dataset).

Name the Feature Dataset  and
click the Edit button to choose
a projection.

Or you might import preexisting coverages or shapefiles 
to the Feature Dataset as Feature Classes.

Specify Domains in ArcCatalog for tagging in ArcMap

Type in the Name of the new Feature Class,
then click which Type of Feature Class, and 
click Next button.

Add data  (the yellow button with plus symbol), and select the Geodatabase 
previously created with Dataset.

It plots with default symbols, but you can easily change that with a 
lookup table, styles or manually.

Here, I added the Lookup Table

To symbolize with the Lookup Table,
 join the table to the polygons.

Bring up the Layer Properties for the Polygons, Symbology Tab,
and choose Categories> Match Symbols in a Style.  
Select Value field, and Style, and Match Symbols button.

TIPS

1A

1B

1C

1D

2A

3

2B

2C

2D

Convert SymbolSets from Workstation Arc to Styles with the SymbolConverter.exe available online at:
http://arcobjectsonline.esri.com/default.asp?URL=/ArcObjectsOnline/Samples/ArcMap/Symbology/Symbols/
AI%207x%20Symbol%20Conversion/SymbolConverter.htm

Try using Domains to simplify tagging in ArcMap.   They are the range of values allowed for a column in a database.  

If printing from ArcMap is problamatic, export the Layout View of the map to Illustrator or EPS and print.  

ArcCatalog, ArcMap or ArcToolBox work on imported versions of your coverages and shapefiles, so it is possible to export the 
Geodatabase and work on the files in the Workstation ArcInfo or ArcView if  needed.

Save often in ArcMap, as it can be unstable.

If your data lives remotely on another host, but there is Samba on that host,  map network drives in Windows to the  data first, 
then start ArcCatalog and establish the Connection to Database.  Close ArcCatalog and open ArcMap to work. 

Take the classes online from the Virtual Campus, and do the exersises. 

Practice, and teach it to someone else, and be patient.  Remember how long it took to learn Arc Workstation, and rejoice, 
because you will learn this much faster.

Export the map at a specified scale, to EPS or to Adobe Illustrator

Styles are edited using the Style Manager in ArcMap, and 
may be passed among ArcGIS desktop users. Tools>Styles> 
Style Manager.  Right click on the Name, copy and paste, 
edit new symbol by Properties.

Symbolizing line symbols with a style (no lookup table).
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DESCRIPTION OF MAP UNITS

SURFICIAL DEPOSITS

							Artificial fill (Holocene)—Unconsolidated soil, sand, gravel, 
and crushed rock used to construct roadbed of State 
Route 503 and dams that impound small streams; al-
so includes concrete of Merwin Dam

Alluvial and mass wastage deposits 

 	 	 	 	 Alluvium (Holocene and Pleistocene)—Unconsolidated silt, 
sand, and gravel along Lewis River, Cedar Creek, 
and small tributary streams; poorly sorted to well-
sorted, crudely stratified to well-laminated, locally 
cross-stratified. Deposits inset against, and hence 
postdate, cataclysmic flood deposits (Qfs). Some 
sediments along Lewis River consist chiefly of 
clasts of Mount St. Helens-derived dacitic rocks re-
worked from penecontemporaneous lahar deposits 
upstream

	 		 	 	Talus deposits (Holocene and Pleistocene)—Unsorted accu-
mulations of angular bedrock blocks below cliffs. 
Chiefly rockfall and rock-avalanche deposits. Larg-
est deposits are in upper Johnson Creek and at north 
base of Green Mountain

	 	 	 	 	Landslide deposits (Holocene and Pleistocene)—Diamictons 
of angular bedrock and(or) surficial material trans-
ported down slope en masse. Chiefly deep-seated, 
semi-coherent slumps and internally disrupted rock-
slide, earthflow, and debris-flow deposits. Many 
mapped slides head at arcuate scars and exhibit 
subhorizontal tops, bulbous toes, and hummocky, 
poorly drained surfaces. Slides involving bedrock 
are most abundant in steep, unglaciated terrain in 
northwestern part of quadrangle. Most slides 
caused by failure of weathered, clayey rocks such 
as volcaniclastic strata of units Tvs and Tt, thin, un-
mapped, sedimentary intervals in flow-dominated 
units, or hydrothermally altered rock. Large land-
slide located 3 km northwest of Fargher Lake gen-
erated by slumping of unconsolidated drift

	 	 	 	 	Lake deposits (Holocene and Pleistocene)—Thin-bedded to 
finely laminated clay, silt, and fine-grained sand; 
dark-gray to black, locally contain abundant organ-
ic material. Deposits beneath bed of drained Fargh-
er Lake are at least 11 m thick, include peat, gyttja, 
and several tephra layers recording eruptions at 
Mount St. Helens (Rigg, 1958; Mundorff, 1964; 
Heusser and Heusser, 1980; Doh and Steele, 1983); 
tephrochronology, radiocarbon ages, and pollen 
analysis indicate deposits range [in age] from about 
20,000 to at least 55,000 years old (Grigg and 
Whitlock, 2002). Along Cedar Creek, deformed de-
posit of dark-gray, rhythmically laminated silt and 
clay at least 12 m thick underlies limonite-cement-
ed gravel of probable outwash origin (too small to 
show on map). Small outcrops of unmapped lake 
beds locally present along shore of Lake Merwin

	 	 	 	 Cataclysmic-flood deposits, sand and silt facies (Pleisto-
cene)—Unconsolidated silt and clay as much as 5 
m thick beneath terrace surfaces as high as 300 ft 
(90 m) along Lewis River and lower Cedar Creek. 
Overlie Mount St. Helens-derived alluvium and 
glacial outwash. Fresh exposures in small slump 
scarps reveal blue-gray rhythmites, each bed sever-
al cm thick, but in more typical weathered expo-
sures silt is oxidized light brown and bedding is in-
conspicuous. Composed largely of quartz, feldspar, 
and conspicuous muscovite, indicating upper Co-
lumbia River Basin provenance. Interpreted as 
slack-water deposits of colossal jökulhlaups initi-
ated by repeated failure of ice dam at Pleistocene 
Lake Missoula in Idaho and Montana during the 

late Pleistocene (Bretz, 1925, 1929, 1969; Allison, 
1978; Baker and Bunker, 1985; Waitt, 1985). Radi-
ocarbon and tephrochronologic data for the slack-
water deposits (Waitt, 1994; Clague and others, 
2003) indicate depositional ages between about 
17,000 and 13,000 14C B.P.

	 	 	 	 Basaltic hyaloclastite deposits (Pleistocene)—Weakly ce-
mented basaltic sand and grit. Form north-thicken-
ing wedge-shaped deposit as much as 10 m thick 
along north shore of Lake Merwin near mouth of 
Cape Horn Creek and small terrace on opposite 
lakeshore to south. Dark greenish to yellowish-
brown, poorly sorted, crudely stratified. Composed 
predominantly of angular clasts as large as 1 cm 
across of black (pale brown in thin section), parti-
ally palagonitized, moderately vesicular to nonve-
sicular, olivine- and plagioclase-phyric basalt; 
contain dispersed foreign clasts, including rounded 
clasts of Tertiary bedrock and rip-up clasts of sub-
jacent glaciofluvial deposits; interbedded with flu-
vial cobble gravel. Unconformably overlie Amboy 
Drift till (Qat) and underlie Ape Canyon-age allu-
vial and lahar deposits (Qsa). Chemical composi-
tion of basaltic clasts (A.M. Sarna- Wojcicki, writ-
ten commun., 2000) dissimilar to those of known 
Quaternary basalts exposed nearby (Evarts and 
Ashley, 1990a, 1991). Beds near Cape Horn Creek 
dip variably (20-70°) to south. Deposits appear to 
constitute eroded remains of apron or delta gener-
ated by phreatomagmatic eruptions from an unex-
posed source vent located to north

	 	 	 	 	Gravel of Johnson Creek (Pleistocene)—Highly weathered 
deposits of weakly consolidated, poorly sorted, 
crudely bedded, cobbly pebble gravel, sand, and 
clayey silt that cap interfluves between Johnson 
and Colvin Creeks at elevations between about 800 
and 1000 ft (260 to 305 m); at least 7 m thick. 
Subrounded to angular clasts, some as large as 15 
cm across, consist entirely of locally derived rock 
types; most clasts smaller than 7 cm are thorough-
ly weathered to clay. Gravel generally clast sup-
ported; locally possesses abundant matrix of 
coarse-grained sand and texturally resembles de-
posits of hyperconcentrated flood flows (Smith, 
1986). Interpreted as sediment deposited when 
lower parts of Johnson and Colvin Creeks were 
blocked by a glacier occupying the Lewis River 
valley

Deposits derived from the Mount St. Helens volcanic center

	 	 Deposits of Swift Creek eruptive stage (Pleisto-
cene)—Unconsolidated sand and gravel along 
north valley wall of Lewis River directly west of 
Merwin Dam and near mouth of Colvin Creek. 
Clast population of most beds dominated by light-
colored, porphyritic dacites like those erupted 
from the ancestral volcanic center at Mount St. 
Helens. Chiefly alluvium but include fine-grained 
lahar and lahar-runout deposits and, at river level 
near Merwin Dam, a diamict with dacite boulders 
of hornblende-hypersthene dacite as large as 3 m 
across. Composition of clasts in diamict indicates 
deposition during the Swift Creek eruptive stage 
(M.A. Clynne, written commun., 2002), approxi-
mately 21,000 to 10,000 14C years B.P. (Crandell, 
1987). Upper part of unit near Merwin Dam in-
cludes younger slope-mantling deposits according 
to Major and Scott (1988)

 	 Deposits of Ape Canyon eruptive stage (Pleisto-
cene)—Unconsolidated, stratified sand and gravel 
composed predominantly of light-colored dacitic 
debris from ancestral Mount St. Helens; beds poor-
ly to well sorted, typically massive; include pebbly 
to bouldery lahar and lahar-runout deposits as well 
as alluvium formed by reworking of lahar deposits. 
Exposed locally along north shore of Lake Merwin 
east of Cape Horn Creek and in valley walls about 
1.5 km above mouth of Johnson Creek; in both pla-
ces unconformably overlie Amboy Drift (Qao and 
Qat); locally as thick as 12 m. Nearly all clasts are 
distinctive coarsely porphyritic quartz + biotite ± 
cummingtonite-bearing dacite of the kind erupted 

from Mount St. Helens during the Ape Canyon 
eruptive stage (approximately 50,000 to 36,000 
14C years B.P. according to Crandell, 1987); clasts 
of younger eruptive stages are absent (M.A. 
Clynne, oral commun., 2003)

	 	 Older Mount St. Helens-derived deposits (Pleisto-
cene)—Small scattered outcrops of unconsolidat-
ed, poorly sorted to well-sorted, massive to lami-
nated sediments composed predominantly of 
quartz + biotite ± cummingtonite-phyric dacitic 
rocks similar to those erupted from the Mount St. 
Helens volcanic center during its earliest period of 
activity (Ape Canyon eruptive stage of Crandell, 
1987). Overlie Amboy till high above valley floors 
in Cape Horn Creek, Husky Creek, and Pup Creek. 
Largest deposit, at 1500 ft (460 m) elevation in 
Cape Horn Creek, is 9-m-thick section of well-
bedded clay, silt, sand, and gravel; includes proba-
ble lahar deposits, light-gray, feldspar-rich sandy 
layers, beds of pale yellow to orange-brown, 
weathered pumiceous tephra, and varved clay and 
silt. Character of sediments and position well 
above valley floors suggests deposition was trig-
gered by eruptions at Mount St. Helens and occur-
red in glacier-margin lakes at time when a glacier 
occupied Lewis River valley (Evarts and others, 
2003). 40Ar/39Ar age of plagioclase extracted from 
bed of slightly reworked pumice lapilli in Cape 
Horn Creek outcrop is 269±13 ka (table 2), consid-
erably older than other known products of the 
Mount St. Helens center

Glacial deposits

 	 	 	 	 Amboy Drift (Pleistocene)—Moderately weathered till and 
glaciofluvial deposits (Mundorff, 1984) character-
ized by weathering profiles about 2 m thick, devel-
opment of weathering rinds 1-2 mm thick on apha-
nitic andesitic clasts in upper part, and widespread 
presence of quartz-, biotite-, and cummingtonite-
bearing dacite clasts derived from the ancestral 
volcanic center at Mount St. Helens. Based on 
weathering characteristics, Amboy Drift is correla-
tive with Hayden Creek Drift, which Crandell and 
Miller (1974) interpreted to be the product of the 
penultimate glaciation in the Washington Cascade 
Range. Age poorly known; Grigg and Whitlock 
(2002) suggest age of about 55 ka for periglacial 
deposits near Fargher Lake but reworked syngla-
cial tephra in Cape Horn Creek (Qso) has age of 
269±13 ka (table 2)

						—Outwash—Poorly consolidated pebbly to cobbly gravel and 
sand forming complex assemblage of terraces 
along Lewis River and Cedar Creek. Deposits 
crudely stratified, moderately to well sorted; com-
monly weakly cemented by limonite or clay. Com-
posed mostly of well-rounded clasts of diverse vol-
canic rocks, some with grooved or striated surfa-
ces, similar to those in associated till (Qat). Light-
gray, feldspar-rich sandy beds dominated by ances-
tral Mount St. Helens rocks locally interbedded 
with gravel. Interpreted as glaciofluvial deposits 
deposited during retreat of Lewis River glacier in 
late Pleistocene time; may locally include older 
outwash. Elevations of terrace surfaces that are un-
derlain by outwash in Lewis River valley range 
from about 700 ft (215 m) near northeast corner of 
quadrangle to 300 ft (90 m) or less near mouth of 
Cedar Creek; semi-continuous outwash-terrace sur-
face along Cedar Creek declines in elevation from 
450 ft (135 m) in east to about 300 ft (105 m) west 
of creek mouth. In many places, most conspicuous-
ly at Etna, multiple terrace surfaces are evident; 
lower terraces may be erosional surfaces cut into 
older outwash deposits or may reflect younger 
pulses of aggradation during the Amboy glacia-
tion. All terrace surfaces below 300 ft (90 m) ele-
vation coated with cataclysmic flood deposits (Qfs)

	 	 	 	 	 —Till—Unconsolidated to compact, massive diamicton that 
blankets much of terrain south of Lake Merwin 
and forms discontinuous cover north of Lewis Riv-
er to elevations as high as 1750 ft (530 m). As 
much as 15 m thick; generally shown only where 
thick and extensive enough to obscure bedrock. 
Consists of angular to rounded clasts up to boulder 
size, some grooved or striated, dispersed in matrix 
of sand, silt, and clay; locally includes stratified 
drift, ice-contact deposits, outwash, lake deposits, 
loess, and postglacial colluvium. Fresh till typical-
ly light brownish to bluish gray. Composed chiefly 
of diverse volcanic rocks similar to Tertiary rocks 
of the western Cascade Range, but commonly con-
tains clasts similar to middle Pleistocene olivine-
phyric basalts and basaltic andesites erupted from 
monogenetic vents in the Lewis River drainage up-
stream from map area (Evarts and Ashley, 1990a, 
1991); clasts of quartzite and basalt reworked from 
Troutdale Formation rare to absent; conspicuous 
light-colored clasts of coarsely porphyritic quartz-, 
cummingtonite-, and biotite-bearing dacite of the 
type erupted from the ancestral Mount St. Helens 
volcanic center (Crandell, 1987) are a minor but 
widespread component in some till, especially 
north of Lewis River

 				Drift of Mason Creek (Pleistocene)—Deeply weathered drift. 
Mapped as Amboy Drift by Mundorff (1984) but 
more intensely weathered, with weathering rinds 
on aphanitic andesitic clasts ranging from 2 to 10 
mm thick and averaging about 5 mm thick. Lacks 
quartz- and biotite-bearing dacitic clasts derived 
from Mount St. Helens. Interpreted by Crandell 
(1987) to record a glacial episode correlative with 
or older than the Wingate Hill Drift of the Mount 
Rainier region (Crandell and Miller, 1974), esti-
mated by Colman and Pierce (1981) and Dethier 
(1988) to have occurred between 300 and 600 ka

	 	 	 	—Outwash—Semi-consolidated, generally limonite-cemented 
gravel, sand, and silt forming dissected terrace 
remnants with surface elevations between about 
400 and 700 ft (120 and 215 m) in valleys of Cedar 
Creek and Lewis River. Most beds moderately to 
well sorted. Typically composed of well-rounded 
cobbles and pebbles lithologically similar to clasts 
in older till (Qmt). Comprises probable glaciofluvi-
al deposits related to one or more episodes of pre-
Amboy glaciation; as mapped, may also include 
minor deposits of Amboy age

	 	 	 	 	 	—Till—Dark-brown, unconsolidated to moderately compact 
diamicton. As much as 30 m thick. Distinguished 
from Amboy Drift by more intensely weathered 
condition; distinguished from Troutdale Formation 
by texture and an abundance of Cascade-derived 
volcanic clasts; locally contains scarce clasts of 
olivine-phyric basalt or basaltic andesite probably 
eroded from middle Pleistocene volcanic centers in 
the Lewis River drainage upstream from quadran-
gle (Evarts and Ashley, 1990a, 1991). Overlies 
Troutdale Formation in area beyond Amboy-age 
moraines west of Fargher Lake; also present in 
patchy exposures in Lewis River valley at higher 
elevations than Amboy Drift. A similar deposit 
northeast of Fargher Lake also tentatively assigned 
to this unit. May include deposits of more than one 
glacial advance. Best exposed in valley of Mason 
Creek in Battle Ground quadrangle to south (Ho-

ward, 2002)

BASIN-FILL DEPOSITS

	 	 	 	 	Troutdale Formation (Pliocene and (or) Miocene)—Semi-
consolidated pebble and cobble conglomerate with 
sparse lenses of friable sandstone; massive, poorly 
sorted to well-sorted and clast-supported, with 
openwork fabric or sandstone matrix. Underlies 
broad, south- to southwest-sloping surface in 
southwestern part of quadrangle, part of the Trout-
dale bench of Mundorff (1964). Clasts well round-
ed; clast population dominated by cobbles of ba-
salt from the Columbia River Basalt Group but 
typically includes some light-colored granitic and 
quartzofeldspathic metamorphic rocks, and distinc-
tive, white to light-gray, iron-oxide stained quartz-
ite; clasts of volcanic rocks eroded from Cascade 
Range are scarce. Sandstone interbeds and matrix 
of conglomerate range from basaltic grit to mica-
ceous arkose compositionally similar to sandy 
beds of Sandy River Mudstone (Tsr). Clasts in 
sandstone and conglomerate are of rock types for-
eign to the Portland Basin; indicates dominant 
source areas east of the Cascade Range and deposi-
tion by the ancestral Columbia River. In most pla-
ces, upper several meters are weathered to reddish-
brown clayey soil; in such areas, presence of scat-
tered, iron-stained, brown to yellow quartzite peb-
bles in soil is the only indicator of protolith. Water 
wells in area south of Highland penetrate as much 
as 70 m of conglomerate and show that weathering 
extends to depths exceeding 30 m (Mundorff, 
1964; Swanson and others, 1993)

	 	 	 	 Sandy River Mudstone (Miocene)—Light grayish-green to 
pale-brown, poorly indurated arkosic, tuffaceous 
and carbonaceous claystone, siltstone, sandstone, 
and minor pebble conglomerate. Poorly exposed in 
valleys of Riley and Lockwood Creeks near south-
west corner of map area. Planar and trough cross-
beds and cut-and-fill structures common in sandy 
beds indicate fluvial depositional environment; 
fine-grained deposits with thin lignite interbeds 
probably represent overbank settings on broad 
floodplain. Equivalent to lower member of Trout-
dale Formation of Mundorff (1964) and fine-
grained member of Troutdale Formation of Ho-
ward (2002). Age is poorly constrained. Plant fos-
sils from near top of unit at localities outside of 
quadrangle were assigned late Miocene or Pliocene 
ages (Trimble, 1963; Mundorff, 1964; Tolan and 
Beeson, 1984), and unit is generally considered to 
postdate Columbia River Basalt Group (Trimble, 
1963; Swanson and others, 1993). Near Woodland, 
however, (Evarts, 2004), flows of the Grande 
Ronde Basalt overlie, are banked against, or in-
vade this unit, so base must be as old as late early 
Miocene

BEDROCK

Intrusive rocks

						Gabbro (Oligocene?)—Scattered small intrusions of medium- 
to coarse-grained, hypidiomorphic granular gab-
bro; most abundant near Davis Peak. Composed of 
euhedral to subhedral plagioclase (60-65 percent; 1 
to 3 mm long) and olivine (1-7 percent; 1 to 3 mm 
across), interstitial to subpoikilitic augite (12-30 
percent; 1 to 2 mm across) and hypersthene (as 
much as 14 percent; 1 to 3 mm across), and subhe-
dral to anhedral Fe-Ti oxide (1-2 percent; =0.5 mm 
across), with as much as 3 percent fine-grained 
quartz, granophyre, and biotite. Olivine commonly 
contains chromian spinel inclusions and is envel-
oped by rinds of granular pyroxene. Moderate to 
intense deuteric alteration to assemblage of chlor-
ite, epidote, actinolite, montmorillonite, and cal-
cite

	 	 	 	 	Diorite (Oligocene?)—Dikes, sills, and irregular, composite 
intrusions of medium- to dark-gray, fine- to medi-
um-grained, seriate to hypidiomorphic granular py-
roxene diorite. Concentrated near Davis Peak cal-
dera. Composed largely of blocky plagioclase 
(average 65 percent; 0.5 to 4 mm long), equant au-
gite (5-17 percent; 0.5 to 2 mm across), equant to 
prismatic hypersthene (7-11 percent; 0.5 to 2 mm 
across), equant to amoeboid Fe-Ti oxide (<2 per-
cent; <0.5 mm across), and, in some samples, an-
hedral olivine (as much as 3.5 percent; 0.5 to 2 
mm across), accompanied by about 5 to 15 percent 
interstitial quartz, granophyre, and (or) chloritic 
clay minerals; some samples contain traces of fine-
grained anhedral K-feldspar, biotite, or horn-
blende; amygdules or miarolitic cavities locally 
common. Texturally and compositionally grada-
tional to basaltic andesite and quartz diorite. Vari-
able but ubiquitous partial alteration of igneous 
phases to some combination of albite, quartz, 
chlorite, epidote, prehnite, actinolite, sericite, 
smectite, kaolinite, calcite, talc, titanite, pyrite, 
and hematite

						Quartz diorite (Oligocene?)—Dikes and small tabular intru-
sions of fine- to coarse-grained pyroxene quartz 
diorite; greenish gray, invariably propylitized. 
Similar to diorite (Tdi) but contains more quartz 
and less pyroxene

					Intrusive basaltic andesite (Oligocene? and Eocene)—Dikes 
of sparsely to coarsely porphyritic basaltic ande-
site. Petrographically similar to basaltic andesite 
flows (Tba); with increasing grain size grades into 
diorite (Tdi)

	 	 	 	 Intrusive andesite (Oligocene? and Eocene)—Dikes and 
small tabular intrusions of aphyric to coarsely por-
phyritic pyroxene andesite. Petrographically simi-
lar to andesite flows (Ta) but commonly more al-
tered; with increasing grain size grades into quartz 
diorite. Most abundant in zone of N. 75° E. -strik-
ing dikes north of Lewis River

	 	 	 	 Intrusive dacite (Eocene)—Dark-gray, platy, sparsely por-
phyritic pyroxene dacite forming tabular to irregu-
lar, commonly composite intrusions that cut cal-
dera-fill deposits near Davis Peak; unit also in-
cludes tabular body of porphyritic dacite in Cedar 
Creek. Intrusions near Davis Peak composed of 
phenocrysts of plagioclase (3-8 percent; 0.5 to 2 
mm long), augite (≤1 percent; 0.5 mm across), hy-
persthene (≤1 percent; 0.5 mm long), and Fe-Ti 
oxide microphenocrysts (≤1 percent ) in a hyalopi-
litic to pilotaxitic, vitric to cryptocrystalline 
groundmass

Volcanic and sedimentary rocks

						Basaltic andesite (Oligocene? and Eocene)—Flows and flow 
breccia of dark-gray to brown, variably vesicular, 
porphyritic to seriate to (rarely) aphyric basaltic 
andesite; unit locally includes minor andesite and 
basalt flows and volcaniclastic rocks too small or 
poorly exposed to map. Typical flows contain phe-
nocrysts of plagioclase (0-40 percent; 1 to 2 mm, 
rarely to 5 mm long), olivine (as much as 5 per-

cent; 0.5 to 2 mm across; commonly partly resor-
bed and surrounded by rinds of granular pyroxene 
and (or) magnetite; almost invariably replaced by 
some combination of smectite, hematite, carbo-
nate, serpentine, and quartz; commonly contains 
minute chromian spinel inclusions), and augite (as 
much as 5 percent; 0.5 to 3 mm across). Some 
flows lack olivine and (or) augite phenocrysts; 
many contain microphenocrysts of Fe-Ti oxide and 
a few contain phenocrysts of hypersthene (as much 
as 5 percent; 0.5 to 1 mm long). Intergranular to 
trachytic groundmass consists of the same miner-
als plus minor altered interstitial glass. Alteration 
highly variable in intensity and mineralogy, de-
pendent primarily on proximity to intrusions; sec-
ondary assemblages include albite, quartz, zeolites 
(including stilbite and laumontite), chlorite, epi-
dote, prehnite, pumpellyite, actinolite, hornblende, 
sericite, smectite, kaolinite, calcite, talc, titanite, 
pyrite, and hematite

							Andesite (Oligocene? and Eocene)—Flows and flow breccia 
of medium-to dark-gray, variably vesicular, aphy-
ric to porphyritic pyroxene andesite. Unit locally 
includes small flows of basaltic andesite and dacite 
and thin volcaniclastic interbeds. Typically con-
tains phenocrysts of plagioclase (1-25 percent; 1-5 
mm long), augite (0-5 percent; <0.5 to 3 mm 
across), hypersthene (0-3 percent; <0.5 to 3 mm 
long), Fe-Ti oxide (<0.5 percent; <0.5 mm across), 
and rare altered olivine (<1 percent; as large as 2 
mm across) in an intergranular, intersertal, pilotax-
itic, hyalopilitic or cryptocrystalline groundmass; 
some sparsely porphyritic andesites lack augite or 
hypersthene or both. Alteration similar in mineral-
ogy and intensity to that described for basaltic an-
desite (Tba)

	 	 	 	 	 Tuff (Oligocene? and Eocene)—Heterogeneous unit com-
posed of andesitic to rhyolitic tuff, pumice- and 
lithic-lapilli tuff, and tuff breccia; very poorly 
sorted, matrix-supported, relatively coarse-grained 
deposits predominate; inferred to be mostly of py-
roclastic-flow and lahar origin but doubtless in-
cludes some air-fall tuff and reworked debris. As 
mapped, includes sequences of tuffaceous rocks in-
terbedded with and gradational to subordinate 
pumice-poor epiclastic sedimentary rocks. Gener-
ally light colored, ranging from white to light-gray 
to light greenish and yellowish brown. Carbonized 
woody debris is present in some lapilli tuff, espe-
cially near base of tuff beds. Phenocrysts rarely 
constitute more than 10 percent of juvenile materi-
al in tuff and include plagioclase, augite, hyper-
sthene, and Fe-Ti oxide, but no quartz, hornblende, 
or biotite. Altered to similar extent as units Tvs, 
Tba, and Ta

	 	 	 	 Rhyolite of Bald Mountain (Eocene)—Light- to medium-
gray, porphyritic hypersthene rhyolite that under-
lies Bald Mountain; highly jointed and locally pla-
ty. Contains phenocrysts of plagioclase (10-15 per-
cent; 1 to 3 mm long) and hypersthene (about 2 
percent; 0.5 to 2 mm long), and microphenocrysts 
of Fe-Ti oxide (≤1 percent; ≤0.3 mm across) in a 
devitrified cryptocrystalline groundmass of feld-
spar, quartz, and smectite. Most outcrops are high-
ly weathered, with plagioclase phenocrysts largely 
replaced by chalky white kaolinite and hyper-
sthene phenocrysts replaced by yellowish smectite. 
Unit contains no apparent internal flow boundaries 
or associated fragmental deposits, suggesting it is 
the eroded core of a dome or shallow plug

						Olivine basalt (Eocene)—One or more flows and flow brec-
cia of porphyritic to seriate basalt and basaltic an-
desite; medium- to dark-gray or greenish gray, or-
ange-weathering, commonly diktytaxitic; contains 
conspicuous, red to orange, variably altered oli-
vine as the sole or dominant phenocryst phase. Ex-
posed in sporadic outcrops between Cedar Creek 
and Bald Mountain. Olivine phenocrysts (as much 
as 5 percent; 0.5 to 2 mm across) partly to com-
pletely replaced by smectite ± hematite; contain 
numerous tiny octahedral chromian spinel inclu-
sions. Medium-grained, intergranular to subophitic 
to trachytic groundmass composed of plagioclase, 
augite, Fe-Ti oxide, and minor interstitial glass al-
tered to smectite. Smectite and zeolite fill irregular 
microvesicles

						Volcaniclastic sedimentary rocks (Eocene)—Diverse assem-
blage of continental volcaniclastic rocks of infer-
red epiclastic origin. Consist of thin- to thick-bed-
ded, well-sorted to poorly sorted siltstone, sand-
stone, conglomerate, and breccia, all composed 
mostly of volcanic debris. Locally include thin 
beds of pumiceous pyroclastic rocks and lava 
flows too small or poorly exposed to map. Beds 
are most commonly light green to olive green or 
greenish gray but some are white, tan, or brown. 
Texturally and compositionally immature; most 
abundant clasts are volcanic rocks petrographically 
similar to interbedded lava flows and tuffs; other 
components include plagioclase, Fe-Ti oxide, and 
pyroxene crystals, pumice, vitric ash, fine-grained 
dioritic rocks, and plant remains. Interpreted as de-
bris eroded from older and penecontemporaneous 
volcanoes and deposited by normal fluvial and la-
custrine processes in low-lying medial to distal in-
tervolcano environments. Typically display intense 
alteration to assemblages like those in interbedded 
lava flows of units Ta and Tba

 						Tuff of Davis Peak (Eocene)—Pyroclastic and associated de-
posits of Davis Peak caldera

	 	 	 	 Caldera-fill facies—Assemblage of complexly interbedded 
pumiceous tuff and diamictite within Davis Peak 
caldera. At least 500 m thick. Composed chiefly of 
olive-green to brown, variably compacted, por-
phyritic, dacitic pumice-lapilli tuff, intercalated 
with a variety of poorly sorted lithic breccias inter-
preted as landslide deposits generated by collapse 
of unstable caldera walls during paroxysmal erup-
tion; locally includes stratigraphically coherent 
megaclasts of precaldera rocks tens of meters 
across (not mapped separately). Proportion and 
rock type of lithic fragments in lapilli tuff highly 
variable; angular clasts of mafic to silicic lavas 
similar to precaldera units are most common. Tuff 
and breccias are typically propylitized, but strik-
ingly fresh, black, glassy, plagioclase- and pyrox-
ene-phyric, densely welded vitrophyre crops out 
above 2300 ft (700 m) elevation on south flank of 
Davis Peak; plagioclase from this tuff yielded an 
40Ar/39Ar age of 35.2±0.3 Ma (table 2)

	 	 	 	 Outflow facies—Bed of porphyritic, densely welded, dacitic 
tuff exposed east of Bald Mountain. As much as 30 
m or more thick. Resembles caldera-fill vitrophyre 
exposed at Davis Peak (Tdpc) and has analytically 
indistinguishable 40Ar/39Ar age (table 2); interpret-
ed as outflow facies of pyroclastic deposits filling 
Davis Peak caldera (Tdpc)

					Dacite (Eocene)—Scattered flows and flow breccia of variably 
porphyritic pyroxene dacite; dark-gray, platy, 
flow-banded, and locally vesicular. Typically con-
tains phenocrysts of plagioclase (5-25 percent; 1 to 
3 mm long), hypersthene (1-2 percent; 0.5 to 1 
mm), and, in some samples, augite (≤2 percent; 0.5 
to 1 mm), and microphenocrysts of Fe-Ti oxide 

(<0.5 percent) in a pilotaxitic, hyalopilitic, cryp-
tocrystalline, or spherulitic groundmass. Locally 
contains as much as 3 percent xenoliths. Excep-
tionally porphyritic flow in Cedar Creek contains 
plagioclase (25 percent; 1 to 3 mm long), augite 
(3-5 percent; 0.5 mm across), and hypersthene (3-5 
percent; 0.5 mm across) phenocrysts, Fe-Ti oxide 
microphenocrysts, and abundant small microdiorit-
ic blobs. Dacite commonly exhibits minor to per-
vasive low-temperature alteration, which imparts 
greenish, pinkish, and purplish colors; fine-grained 
alteration assemblages include quartz, calcite, al-
bite, hematite, celadonite, montmorillonite, kaolin-
ite, and titanite

					Rhyolite (Eocene)—Reddish-orange porphyritic rhyolite, with 
highly contorted flow banding; crops out in bank 
of Cedar Creek, about 1 km east of Etna. Contains 
phenocrysts of plagioclase (5-10 percent; 0.5 to 1 
mm long) and microphenocrysts of altered pyrox-
ene (<1 percent) and Fe-Ti oxide (<1 percent) in 
quartz-rich microcrystalline groundmass

	 	 	 	 	Dacite of Marble Creek (Eocene)— Flows and breccias of 
porphyritic pyroxene dacite exposed between Cape 
Horn and Husky Creeks; also present on lower 
west slope of Green Mountain east of Merwin 
Dam; light greenish, yellowish, pinkish, and pur-
plish gray to medium gray; commonly platy. Com-
posed of plagioclase (8-15 percent; 1 to 3 mm 
long) and orthopyroxene (≤2 percent; 0.5 to 1 mm 
across) phenocrysts and Fe-Ti oxide (≤1 percent; 
<0.3 mm across) microphenocrysts in a cryptocrys-
talline, pilotaxitic to hyalopilitic groundmass. In 
most places pervasively overprinted by hydrother-
mal alteration and (or) contact metamorphism; pla-
gioclase largely replaced by secondary assemblag-
es including albite, calcite, montmorillonite, heu-
landite, epidote, sericite, and chlorite; pyroxenes 
totally replaced by some combination of smectite, 
quartz, calcite, chlorite, epidote, and pyrite

	 	 	 Basalt (Eocene)—Isolated flows of porphyritic plagioclase-
phyric basalt in Colvin Creek and Cape Horn 
Creek drainages. Contains phenocrysts of plagio-
clase (as much as 15 percent; 1 to 3 mm long; par-
tially altered to albite + smectite), olivine (3-5 per-
cent; 1 to 3 mm across; totally altered to quartz, 
smectite, and hematite; contains small chromian 
spinel inclusions), and, in some flows, a few per-
cent augite in intergranular to trachytic ground-
mass. Some plagioclase crystals embayed and 
probably xenocrysts

	 	 	 Hypersthene basaltic andesite (Eocene)—Flows and flow 
breccia of dark-gray, densely porphyritic, hyper-
sthene basaltic andesite that crop out on upper 
west valley wall of Johnson Creek. Part of  ap-
proximately 225-m-thick sequence exposed in ad-
jacent Woodland quadrangle. Typical flow con-
tains phenocrysts of plagioclase (about 35 percent; 
1 to 2 mm long), hypersthene (6-8 percent; 1 to 3 
mm long), and augite (<0.5 percent; 1 to 2 mm 
across) in intergranular to intersertal groundmass 
of feldspar, pyroxene, Fe-Ti oxide, and local inter-
stitial quartz and smectite

  	 	Contact—Dashed where approximately located; short-dashed 
where inferred; dotted where concealed

  	 	Fault—Dashed where inferred; dotted where concealed. Ball 
and bar on downthrown side. Arrows show relative 
horizontal movement

  	 Reverse fault—Dashed where inferred, dotted where con-
cealed. Sawteeth on upper plate

  			 Caldera margin of Davis Peak—Approximately located

  	 Buttress unconformity—Approximately located. Hatchures 
face  intracaldera tuff deposited against fault-
bounded blocks of pre-caldera rocks within Davis 
Peak caldera

				Syncline—Approximately located, arrow showing direction of 
plunge

  				Strike and dip of beds

  			Strike and dip of compaction foliation in pumiceous lapilli 
tuff

										Inclined
  					
  				Strike and dip of platy parting in lava flows
										Inclined
  								Vertical

  				Crest of moraine

  				Sample locality for chemical analysis—See table 1

					Sample locality for 40Ar/39Ar age determination and age in 
Ma (±1-σ error)—See table 2

    		Area of propylitic alteration

    		Area of tourmalinite alteration
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